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ARTICLE

Freeing Up (lots of) Disk Space!

T

emporary files, especially those
used by Windows Update or
resulting from upgrading to a
new “feature update” in Windows 10,
can take up gigabytes of disk space but,
did you know that Windows has some
built-in tools that will allow you to
reclaim this disk storage? One option is
to use a utility program located in the
administrative toolbox, while Windows
10 users can access a similar feature
through the Settings menu.

you see the box labeled “Clean up system files” in the lower-left corner of the
program window? This is the key to
removing more files and, in particular,
eliminating some potentially very large
files that are taking up your disk space.
So, immediately click the button
“Clean up system files” as this will
provide the most comprehensive cleanup options. Disk Cleanup will reload,
but this time, it will offer additional
categories that can be deleted.

Disk Cleanup
Run this program by navigating to the
Start Menu | Windows Administrative
Tools | Disk Cleanup (or simply search
for Disk Cleanup in the search box).
Select the disk drive where Windows is
installed, usually (C:), and press OK.
Windows will respond with a list of
categories of files that can be deleted.

You could start selecting file categories
that you wish to delete but - wait! - do

Next Meeting:

If you intended to delete them, and you
have no intention or need to recover
them, this category of files can also be
selected for deletion.
However, if this is the first time that
you are running Disk Cleanup, you
should check each category, and read
the description of the files involved.
You need to decide if you wish to retain certain categories of files or delete
them. It’s your option to check the category and have the files deleted, or
uncheck the box and retain the files in
any given category, depending on how
you use the files stored on your hard
drive.
As indicated earlier, considerable
amounts of disk space can be retrieved.
For example, note that for the disk contents shown in the screenshot above,
“Windows Update Cleanup” is using
5.61 GB of storage! The files in this
category are used by Windows if you
want to roll-back a Windows update
that is causing problems. As a general
rule of thumb, if your computer is

“Clean up system files” adds
Windows Update Cleanup

Initial cleanup options

by Alan German and Chris Taylor

At this point, you can check / uncheck
the boxes for the categories that you
wish / do not wish to delete. For example, it’s completely safe to have
“Temporary Internet Files” deleted
since these are just cached web pages
and images which your browser will
reload the next time you visit the relevant web site. Similarly, if you have
manually deleted some files, they will
have been sent to the “Recycle Bin”.
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April Raffle

March Prize Winners

I

t is so convenient to be able to carry important files
and programs with you all the time. Are you always
twiddling your thumbs waiting for your files to
write to your pokey USB 2.0 flash drive? Are you always running out of room with your tiny 64 GB flash
drive? Do you worry that your 2-inch flash drive will
snap off when you forget to unplug it and you tuck
your laptop in your backpack?

Our raffle prize, a copy of the Glass Wire Firewall, was won by Rob
Murray.
And Marcello Qualizza took home our door prize of a "No Tech" BBQ
Cleaner!!

We have just the thing for you: a SanDisk 256GB Ultra
Fit USB 3.1 Flash Drive (yes, you r ead that r ight –
256 GB) that is fast and so tiny that it bar ely pr otrudes from your laptop.
Tickets are just $1 for one, $2 for three, or $5 for ten.

Coming Up…
The April meeting will be held in one of the back rooms, not the
main sanctuary. Signs will be posted at the main entr ance.

Wednesday, April 10th, 2019
Topic: Basic digital photo editing using fr ee softwar e
Speaker: Lynda Buske
It is easy to take hundreds of photos with your digital camera.
But then what? Lynda will help you discover easy ways to organize and enhance your photos by adjusting light, colour, and
composition so you will be proud to share or print them. Lynda
will be using free photo editing software exclusively during the
presentation.
Lynda is passionate about taking photos while travelling far
away or close to home. She loves showing people how to take
better photos and then enhance them through photo editing. She
has made dozens of online photo books as souvenirs of her travels and important family events. She sends out a "photo of the
week" to fans and friends.

May 8th, 2019
Topic: Effective backup str ategies
Speakers: Alan Ger man and Chr is Taylor
June 12th, 2019
Annual Pizza Night and eWaste event followed by our
speaker:
Speaker: Camer on Bell, CEO CANImmunize
Topic: Vaccination Tr acking App
October 9th, 2019
Topic: Member s' Favour ites
Speakers:
Lawrence Patterson (video editing),
Bob Walker and Bob Herres (blue tooth hearing aids),
Alan German (free Software),
Chris Taylor (Wacom tablet)
Time permitting:
Bob Walker (Online and Cross-Border Shopping)

For meeting updates and additional details, visit http://opcug.ca/regmtg.htm.

2019 CALENDAR
Meetings

Date

Time and Venue

OPCUG General Meeting

Wednesday, April 10th

7:30 p.m. at the Riverside United Church, 3191 Riverside Drive,
Ottawa. Parking is free. OC Transpo bus #87 stops nearby.
Visit http://opcug.ca/regmtg.htm for directions.

Q&A Session

Wednesday, April 10th

Immediately following the OPCUG General Meeting.

Beer BOF (Wing SIG East) Wednesday, April 10th

10:00 p.m. (after the Q&A) at the Riverside Pub, 3673 Riverside Drive.
Turn left onto Riverside Dr. from the Church.
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ARTICLE

Google Chrome’s cache

I

t bugs me that Google doesn’t let you change
either the location or maximum size of Chrome’s
cache through its Settings page. The cache is located under your Windows profile folder; normally
C:\users\... Its size is determined at Chrome’s startup and is based on available space on that drive. On
my computer, the maximum cache size is about
1GB – ridiculously large.

by Chris Taylor

If you also want to limit the size of the cache, you
can add another parameter;
--disk-cache-size=75000000
where the number is the size you want for the cache,
in bytes. In this example, it will limit the cache to 75
million bytes.

I finally decided to do something about this after
upgrading to a solid state drive. Since my C drive
dropped from 1.4 TB to 500 GB, I don’t want the
cache files on my C drive!
One way to modify the cache location is to change
the start-up parameters for Chrome. Start by emptying the current cache. Press Ctrl-Shift-Del while in
Chrome. From the Clear browsing data dialog box,
select Cached images and files and click the Clear
data button. Close Chrome.
Create the folder you want to use for Chrome’s
cache (e,g. d:\ChromeCache). Right-click on the
shortcut you use to start Chrome, and choose Properties. At the end of the Target: line, add a space
and;
--disk-cache-dir="d:\ChromeCache"
where d:\ChromeCache is the folder you created for
the cache.

The drawback of this technique is that the parameters only take effect if Chrome is launched from the
shortcut you modified. If, for example, you launch
Chrome by clicking a link in an email, it will use the
default location and size for the cache.
To change the cache location, there is a better way;
create a symbolic link (shortcut) to your preferred
cache location. Chrome thinks it is using the default
location and Windows redirects things to the new
location.
Step 1 – close all instances of Chrome.
Step 2 – create a new folder where you want the
cache to reside, e.g. d:\ChromeCache

Click OK. When you start Chrome using that
shortcut, it will use the new location for the cache.

Step 3 – delete your current Chrome cache folder.
Make sure you are showing hidden files (File Explorer | View tab | Hidden items). Navigate to
C:\Users\UserName\AppData\Local\Google\Chrom
e\User Data\Default\ (where UserName is your logon name for Windows). Delete the folder below
there called Cache
(Continued on page 6)
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ARTICLE
Windows 7 End of Life—Contingency Planning III

I

n the previous article in this series we explored how
well Linux Mint would run on our computer using a
Live-disk. With this test having proved successful, we
are now ready to install Mint on the machine's hard drive.
And, in order to maintain access to the already-installed
version of Windows we will install Linux in dual-boot
mode.

by Alan German

Now, we come to a critical dialogue box – "Installation Type" (See
Figure 1). Since, at this point, we are creating a dual-boot system,
the default entry to "Install Linux Mint alongside Windows" is
appropriate. Be careful not to select "Erase Disk and install Linux
Mint" since that would remove Windows entirely!

The installer will automatically shrink the size of the Windows partition on the hard drive and create an extended
partition to hold both Linux Mint and an associated swap
area. All we have to do is to specify how much of the hard
disk space we wish to allocate to Linux. Mint needs about
15 GB for the software, and some space for our personal
data files so, if we have room, we should allocate 20-30
GB of space for the Linux system.
The installer will also create a boot menu that will allow
us to select between booting Linux (which will now be the
default) and Windows. Once we power up the computer,
we will have ten seconds to decide which operating system we wish to boot. If we don't make a selection then
Linux Mint will boot automatically. However, as with
almost all things Linux, all these options are configurable.
We can choose to boot Windows by default, and we can
modify the boot-up delay, as we wish.

Figure 1

Booting the computer using our Live-disk brings up
Mint's desktop and, in particular, the "Install Linux Mint"
icon (that we previously ignored). Double-click on this
icon in order to load the installer. There will now be a
series of screens prompting for various parameters relating to the installation. For most of these screens, the default options will work just fine. The first two screens
follow this general rule. With English already selected as
the default language, we simply need to press the
"Continue" button to go to the next screen where we can
accept English (US) for the keyboard layout. Of course, it
is perfectly acceptable to change the defaults if such is
your preference.
The contents of the next screen will depend on whether or
not you are already connected to Wi-Fi. If there is no connection, but one or more is available, the screen will list
the available networks. Select your Wi-Fi network, press
"Connect", and enter the associated password in order to
establish a Wi-Fi connection. Then, on the next screen,
check the box labelled "Install third-party software…"
This will ensure that any proprietary software necessary to
play audio and video files (e.g. MP3 and MPEG) are included in the installation process.
The next dialogue effectively notes that our Live-disk is
mounted and asks if we wish the installer to unmount it.
The safe answer is yes since we don't wish to modify the
Live-disk in any way.

Figure 2
The following screen (see Figure 2) is a representation of the computer's hard drive, with suggested sizes for both the Windows and
Linux partitions that are to be created. My test machine has a 120
GB SSD and the installer suggests reducing the size of the Windows' partition to 89.2 GB and creating a 30.9 GB Linux Mint partition. This is completely in line with the size needed for Mint and
gives plenty of additional space for other files. If you need to
change the partition sizes, simply drag the partition divider to the
left or right as appropriate. Clicking on "Install Now" brings up a
couple of warning messages that the contents of the hard disk are
(Continued on page 5)
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Windows 7 EoL

Word Tables—Part 3 of 3

(Continued from page 4)

to be changed. These sound ominous
since – the changes can't be undone and
they will be written to the disk. However, we want the disk to be partitioned so
it's OK to continue. (And, you do have
full-system backups – don’t you?)
Once the partitioning process has completed, the installation proper begins
with files being transferred to the hard
disk. The installer now asks a further
series of questions, beginning with
"Where are you?" It's really asking in
which time zone are you located, and
so the default of Toronto (Eastern
Standard/Daylight Time) is correct.
[You may also discover that the installer doesn't know that we live in Ottawa.
Montreal (also EST/EDT) is the closest
available city.]
One more screen and we are more or
less done. "Who are you?" wants a
number of data fields completed. Enter
your name. You can type whatever you
wish, e.g. Donald or Donald Duck.
Similarly, you can overwrite the suggested computer name to use any name
that is meaningful to you. I selected
Dell-Inspiron for my old clunker.
The next entry is username. This
doesn't have to be the same as your
name, and I believe that it must be in
lower-case characters. Be careful with
this. I once did a live-demo of a Linux
installation and typed in my friend's
name as John. The installer changed
this to john and I was subsequently
unable to log in since I hadn't noticed
the switch!
Finally, enter a password of your
choice and confirm the entry be entering it in the second box. A green
checkmark will confirm the validity of
the entries. Remember (i.e. write down)
this password! I would suggest leaving
"Require my password to log in"
checked. The login screen will show
the account(s) that is available and you
will be required to enter your password
to log on to the system. The same password will also be required whenever
administrator privileges are required
for any future operation.
Press the Continue button one final
time. Now, sit back, and watch the
pretty slideshow about the features of
Linux Mint and some of its applications, as the progress of the installation

is displayed along the bottom of the
window.
In much less time than it takes to install
a feature update in Windows (!), a dialogue box will pop up indicating that
the "Installation is finished". As indicated, you can continue with the Livedisk but you will be unable to save any
files that you may create (although you
could send them to yourself by E-mail!)
However, if you have been following
the plan, you will already have thoroughly tested Mint using the Live-disk,
so you should be ready to "Restart
Now"!
The computer will reboot but, instead
of loading Windows, the GRUB
(GRand Unified Bootloader) menu will
be displayed. Linux Mint will be selected by default so simply press Enter to
boot into Mint directly from your hard
drive. No waiting required!
Of course, you still have the option of
booting into that "other" operating system, but eventually you are likely to
find yourself doing this less and less.
This should certainly be the case if you
are dual-booting a Windows 7 machine.
Once the support period for Windows 7
has ended there will be no more security patches and using this operating system, particularly over the Internet, will
be highly risky.
Linux, on the other hand, will continue
to have long-term support. Mint 19.1
will be supported through April, 2023
and new long-term support (LTS) versions are released routinely. The distro
is based on Ubuntu which has a regular
schedule for updates with new LTS
versions being released every two
years, each with support for the subsequent five years.
You will also find that Linux is very
reliable and highly customizable. A
vast range of software packages is
available through the Software Manager, Synaptic Package Manager, or a
variety of open-source projects. And,
help is always at hand from the Linux
Mint Forums, searches on Google – or,
from your fellow OPCUG members in
one of our Q&A sessions or on the
OPCUG-Member-Forum!
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By Lawrence Patterson
lawrence@opcug.ca
WORD TABLE TIPS & TRICKS
Now that you’ve explored how to utilize
tables to create documents that pop, lets go
over some basic steps the pros use.
1. Use Excel to create the basics, and copy
and paste the contents into Word;
a. By right clicking and selecting either of
the first two options (with & with out
formatting) you are able to quickly copy
content;
b. Be careful you keep the size of the Excel content within a page width.
2. Use the Design menu to quickly apply
formats;
a. Remember borders our optional and can
be replaced by highlighting rows.
3. Ever copy a table and its boundaries go
beyond the page size, me too, and the
quick fix is to go to Layout > Cell Size >
Auto Fit Window;
4. Ruler is your friend, especially when it
comes to maximizing the size of your columns, so turn it on by clicking on View >
Ruler;
5. Have data that has a consistent separator
between fields (comma, tab, dash, etc.),
highlight the text then click on Insert >
Table > Convert Text to Table and follow
the menu prompt;
a. This could take some experimentation
to get the end result in the way you expect.
6. Experiment with the mouse and look up
other tips as there are multiple ways for
you to move rows / columns within the
table itself;
7. Anything you can do in Word can be done
within a Table Cell (i.e. pictures, tab, bullets, etc.).
Take care.
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Disk Space

(Continued from page 1)

working fine for a few days after an
update is applied, it is highly unlikely
you will ever roll back the update and,
therefore, you can use this option to
clean up large amounts of space.
Note also that, by using “Clean up system files”, and selecting the categories
using large amounts of storage, we
have opted to free up more than 6 GB
of disk space, as opposed to the 44 MB
that was selected initially.
Another potentially huge disk space
hog is “Previous Windows installation
(s)”. In particular with Windows 10,
when “Feature Updates” come out
twice a year, the previous version of
Windows is saved and you have the
option to restore that version by using
Settings | Update & Security | Recovery.

then you will have a nice, clean(er),
shiny hard drive!
Windows 10
Microsoft has announced that “Disk
Cleanup” is deprecated. This means that
– at least for a while – the program will
remain as a part of Windows but, eventually, it will go away.
However, fear not – all the functionality
of “Disk Cleanup” is available in Settings | System | Storage | Free up space
now. And, in this case, all of the file
categories available for deletion are
listed directly; there is no optional system-files button.

Chrome Cache

(Continued from page 3)

Step 4 – start a command prompt
as administrator. In the search
box on the taskbar, type in
CMD. When your see Command
Prompt in the results, right click
on that and choose Run as administrator. In the Administrator: Command Prompt window
that opens, type in;
mklink /D
"C:\Users\UserName\AppData\L
ocal\Google\Chrome\User Data\Default\Cache"
"D:\ChromeCache"
Make sure you replace
UserName with your logon name
for Windows and
D:\ChromeCache with the drive/
folder name you created for the
new cache.
After the command completes,
you will see;

Windows 10's Settings app
Huge savings with "Previous
Windows Installations”
If you are confident that you don’t want
to return to the previous version of
Windows, this category in Disk Cleanup can free up enormous amounts of
space. In the example shown above,
this category is using up 35.5 GB of
space!
Now that we really have selected all of
the file categories that we wish to delete, we can press OK. Disk Cleanup
will “spring” into action and actually
delete the selected files. However,
“spring” is a relative term in this regard. If you select the category
“Windows Update Cleanup”, be prepared for Disk Cleanup to chug away
for an hour or more. But eventually the
cleanup process will terminate – and

However, for "all the functionality", read
almost all the functionality. There is one
feature of “Disk Cleanup” that the Windows 10 Settings app is missing – the
ability to script (and therefore automate)
the process of performing the cleanup. In
this case, rather than saying “Microsoft
giveth and Microsoft taketh away”, we
can only say “Microsoft taketh away”.
So, there you have it – two options to
potentially save you gigabytes of disk
space. You can implement the cleanup
process any time but, as we have seen
above, you probably should be sure to do
so a few days after “Patch Tuesday” (the
second Tuesday of the month), and a
week or two after Windows 10 feature
updates (which come out each spring
and fall)!
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symbolic link created for
C:\Users\UserName\AppData\L
ocal\Google\Chrome\User Data\Default\Cache <<===>>
D:\ChromeCache
If you look at the location
C:\Users\UserName\AppData\L
ocal\Google\Chrome\User Data\Default\ you will see a folder
called Cache that has a shortcut
arrow on it. This folder is now
pointing to the new location you
created and the cached web pages in Chrome will be stored
there.
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OPCUG Free Software Guide—Part 87

T

his guide features an annotated list of free computer
programs. The software mentioned has not been reviewed (except where noted) nor have any tests necessarily been conducted. Consequently, no guarantees are provided that the individual programs will perform as described.
Rather the list of available software is provided for the information of our members who may find one or more of the programs useful.

Compiled by Alan German
and Stewart Bruce

Photo to Video Converter Free Version
This easy-to-use tool will allow you to create MPEG-1 stunning slideshows with your still digital photos. The program
has built-in dynamic pan & zoom and a range of other transition effects And, you can add background music to give a really professional effect to your video presentations.
Web Site: http://www.socusoft.com/photo-to-video-free.php

FreeOffice 2018
SoftMaker FreeOffice 2018 is free to use for both home and
business. It's a complete Office suite with a word processor, a
spreadsheet application and a presentation program. You can
work with either modern ribbons or classic menus and
toolbars, and it's optimized for touch screens. Download this
software for use with either Windows or Linux. After trying it,
you may agree with the program's developers that it is the best
free alternative to Microsoft Office.
Current Release: Version 942
Web Site: https://www.freeoffice.com/en/

nexusimage
The developer's description of this program has to the shortest
on record – "Nothing to say. It's just a simple image viewer."
Current Release: Version 1.1.3.992
Web Site: http://www.xiles.net

Auslogics Registry Cleaner
Does your computer show signs of stability issues, such as
freezing, crashes, or multiple pop-up error messages? Do these
annoying problems reduce your computer's performance and
affect your productivity. Registry Cleaner will clean, repair
and optimize your Windows registry to eliminate errors and
crashes, and restore your computer to smooth and stable operation.
Current Release: Version 7.0.13.0
Web Site: https://tinyurl.com/yckzm9zw

HERE WeGo - Offline Maps & GPS
Getting around is easier with this app's off-line
maps. Take your car, your bike or public transit. If
you’re in a hurry, call a taxi or find car sharing
nearby. Use GPS navigation with voice guidance
in your car. Walk guidance takes you every step of the way.
And, you’ll never miss a transfer when you take public transit.
HERE WeGo will even give you bus ticket prices, taxi fares,
and a heads-up on any traffic slowdowns.
Current Release: Version 2.0.12509
Web Site: https://tinyurl.com/p4oarqg
UFO: Alien Invasion
It is the year 2084. You control a secret organization charged
with defending Earth from a brutal alien enemy. Build up your
bases, prepare your team, and dive head-first into the fast and
flowing turn-based combat. You will have multiple mission
objectives as the aliens' terrifying plot unfolds. You'll have to
watch your back, be quick on your feet, and take the fight to
them. If you don't, humanity is doomed. This open-source
squad-based tactical strategy game is in the tradition of the old
X-COM PC games. Play it on Windows or Linux.
Current Release: Version 2.5
Web Site: https://ufoai.org/wiki/About

MiniTool ShadowMaker 3.0
This utility from Vancouver-based MiniTool Software Ltd.
will make images of disks or individual partitions, and can
create backups of multiple files and/or folders. Disk images
may be restored in full, or mounted and browsed, allowing
individual files and folders to be recovered.
Current Release: Version 3.0
Web Site: https://tinyurl.com/ShadowMaker
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Ottawa PC News is the newsletter of the Ottawa PC Users’ Group (OPCUG), and is

published monthly except in July and August. The opinions expressed in this newsletter may
not necessarily represent the views of the club or its members.
Member participation is encouraged. If you would like to contribute an article to Ottawa PC
News, please submit it to the newsletter editor (contact info below). Deadline for submissions is
three Sundays before the next General Meeting.

Group Meetings
OPCUG meets on the second Wednesday in the month, except July and August, at
the Riverside United Church, 3191 Riverside Drive, Ottawa. Parking is free at the
church. OC Transpo bus #87 stops nearby. Details at http://opcug.ca/regmtg.htm.
Meetings are 7:30–9:00 p.m. followed by a Q&A Session until 10 p.m.
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Web address:
Follow us on Facebook:
Follow us on Twitter:
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Reduce,
Reuse,
Recycle

B

ring your old computer books,
software, hardware, and paraphernalia you want to GIVE
AWAY to the General Meetings, and
leave them at the table near the main
entrance. Please limit magazines to
publication dates under two years.
You may TAKE AWAY any items of
use to you.
Any items left over at the end of the
meeting have to be taken back home
by those who brought them in.

